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Abstract
Vaillant, Nicole M.; Ager, Alan A.; Anderson, John. 2013. ArcFuels10 system 

overview. Gen. Tech. Rep. PNW-GTR-875. Portland, OR: U.S. Department of 
Agriculture, Forest Service, Pacific Northwest Research Station. 65 p.

Fire behavior modeling and geospatial analyses can provide tremendous insight 
for land managers as they grapple with the complex problems frequently encoun-
tered in wildfire risk assessments and fire and fuels management planning. Fuel 
management often is a particularly complicated process in which the benefits and 
potential impacts of fuel treatments need to be demonstrated in the context of land 
management goals and public expectations. The fuel treatment planning process is 
complicated by the lack of data assimilation among fire behavior models and weak 
linkages to geographic information systems (GIS), corporate data, and desktop 
office software. ArcFuels10 is a streamlined fuel management planning and wildfire 
risk assessment system that creates a trans-scale (stand to large landscape) interface 
to apply various forest growth and fire behavior models within an ArcGIS platform 
to design and test fuel treatment alternatives. The new version of ArcFuels has been 
implemented on Citrix at the Forest Service Enterprise Production Data Center, 
eliminating the need for desktop GIS, improving connectivity to the corporate 
geospatial databases housed at the data centers, and enabling sharing of informa-
tion among Forest Service employees. This overview introduces ArcFuels10 and 
the tools available within the system. Further information, including download 
information, demonstration data, and a tutorial, can be found at http://www.fs.fed.
us/wwetac/arcfuels/index.html. 

Keywords: ArcGIS, fire behavior models, forest growth models, fuel treatment 
planning, wildfire hazard, wildfire risk.
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Introduction
ArcFuels was developed to meet the growing need in federal land management 
agencies for tools to facilitate landscape planning and wildfire risk assessments 
(Calkin et al. 2011, Omnibus Public Land Management Act of 2009). For example, 
the Collaborative Forest Landscape Restoration Program (CFLRP), established by 
Title IV of the Omnibus Public Land Management Act of 2009 and the 2010 Cohe-
sive Strategy (Calkin et al. 2011) call for wider use of landscape planning for fuel 
management and the use of risk assessment methods to analyze treatment strate-
gies. The CFLRP, in particular, outlines an analysis framework that includes an “all 
lands” approach for forest restoration, and encourages planners to leverage local, 
national, and private entities to develop landscape fuel management strategies. The 
CFLRP process includes the Wildland Fire Management Risk and Cost Analysis 
Tools Package (R-CAT) that was developed to help measure the cost savings from 
fuel management activities and which requires wildfire risk modeling of manage-
ment alternatives. The 2010 Cohesive Strategy Scientific Report outlines the need 
for a risk-based approach to fire and fuels management at all scales, from national 
budget allocation to project-level planning (Calkin et al. 2011). 

ArcFuels addresses these needs by creating a geospatial analysis and modeling 
environment that can be leveraged to design and test fuel treatments at the stand to 
landscape scales. Linkages to forest vegetation, visualization models, stand-level 
fire behavior models, landscape-level fire behavior models, and fire effects models 
within a geospatial interface facilitate these connections. 

A core strategy of ArcFuels is to facilitate the application of wildfire behavior 
modeling to help quantify the components of risk, especially the relative burn 
probability and intensity from future wildfires. Most wildfire losses on public lands 
stem from large fires that are impossible to predict with empirical data. Wildfire 
simulation modeling fills this need; with careful calibration, simulations can be 
used to spatially quantify fire risk under current conditions and to assess various 
treatment alternatives. Changes in relative risk can be used to see if mitigation 
efforts would be effective at reducing risk to values of interest. The application of 
simulation models for wildfire management planning continues to grow, with case 
studies that span many scales and problems. For instance, at project scales, wild-
fires are simulated across a planning area to examine how different fuel treatment 
alternatives affect factors such as potential fire behavior, tree survivability, smoke 
production, wildlife habitat, and soil within and outside of treatments. 

ArcFuels is a geospatial 
analysis and modeling 
environment that can  
be leveraged to design 
and test fuel treatments 
at the stand to land-
scape scales.
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In this document, we describe several new developments in ArcFuels10 that 
include the following: 
1.	 A reengineered version for ArcMap 10®1 developed within the Microsoft 

.NET framework for improved portability and compatibility with newer 
versions of ArcGIS®. 

2.	 Implementation on the Forest Service Citrix server, eliminating the need for 
desktop geographical information systems (GIS), improving connectivity to 
the corporate geospatial databases housed at the data centers, and enabling 
sharing of information among Forest Service employees. 

3.	 Implementation of risk analysis forms that were available in previous ver-
sions only as experimental releases. These functions automate the calcula-
tion of risk components and expected loss as outlined in Calkin et al. 2011.

We envision continued growth for ArcFuels10, especially considering that 
requirements for fuel treatment planning have expanded to include climate change 
impacts and carbon accounting. With multiple and varied objectives, including 
ecosystem restoration, wildlife habitat management, carbon sequestration, and 
responding to climate change issues, systems like ArcFuels10 that are integrated 
with corporate geospatial software and databases will provide a platform to address 
the many issues and analytical tasks associated with wildland fuels management. 

ArcFuels10 At a Glance
ArcFuels10 is a custom toolbar designed for use with ArcMap (fig. 1). The Arc-
Map framework helps users incorporate data from a variety of sources to address 
project-specific issues that typify many fuel treatment projects. ArcFuels10 was 
built to accommodate both ArcGIS raster data (such as LANDFIRE data available 
at http://www.landfire.gov) and/or forest inventory data.

ArcFuels10 provides a logical flow from stand-to-landscape analyses of vegeta-
tion, fuel, and fire behavior, using a number of different models (table 1, fig. 2) in a 
simple user interface within ArcMap. Specific functionality of ArcFuels10 includes: 
1.	 An interactive system within ArcMap to simulate fuel treatment prescrip-

tions with the Fire and Fuels Extension to the Forest Vegetation Simulator 
(FFE-FVS) (Rebain 2010). 

2.	 Automated generation of Excel® workbooks and Stand Visualization 
System (SVS) (McGaughey 1997) images, showing how fuel treatments 
change wildfire behavior and stand conditions over time after FFE-FVS 
modeling.

1 The use of trade or firm names in this publication is for reader information and does not 
imply endorsement by the U.S. Department of Agriculture of any product or service.
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3.	 Scale-up of stand-specific treatments to simulate landscape changes in  
vegetation and fuel from proposed management activities. 

4.	 The ability to modify and reevaluate fuel treatment scenarios.
5.	 Pre- and postprocessing of files for or from FlamMap (Finney 2006) to 

simulate landscape-scale fire behavior and to measure fuel treatment 
performance in terms of wildfire probabilities, spread rates, and fireline 
intensity. 

6.	 Viewing and analyzing spatial fire behavior outputs in ArcMap.
7.	 Tools to aid wildfire risk assessments.

Figure 1—ArcFuels10 toolbar (outlined in red) within ArcMap with the supplied ArcFuels 
demonstration data loaded.
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Table 1—Description of forest growth and fire behavior models linked to ArcFuels101 

Model 	 Description	 Linkage within ArcFuels10

Forest Vegetation Simulator (FVS)	 Individual-tree, distance-independent growth	 Calls the program, creates input  
	 (Crookston and Dixon 2005)2		  and yield model		  data, processes output data, plus 
					     allows interaction in execution
Fire and Fuels Extension to FVS 	 Stand-level simulations of fuel dynamics, 	 Calls the program, creates input  
	 (FFE-FVS) (Rebain 2010)2		  potential fire behavior and fire effects		  data, processes output data, plus 
			   over time		  allows interaction in execution
Stand Visualization System (SVS)	 Generates graphics depicting stand conditions	 Calls the program; creates 
	  (McGaughey 1997)2				    input data
NEXUS (Scott 1999)	 Stand-level spreadsheet that links surface	 Calls the program; creates 
			   and crown fire prediction models		  input data
BehavePlus (Heinsch and	 Stand-level fire behavior, fire effects, and	 Calls the program; SURFACE 
	 Andrews 2010)		  fire environment modeling system		  module fully integrated in the 
					     Behave Calculator
FlamMap (Finney 2006)2	 Landscape-level fire behavior mapping and	 Calls the program, creates input  
			   analysis program		  data, processes output data
Fire Area Simulator (FARSITE) 	 Landscape-level fire spread simulator	 Calls the program, creates input  
	 (Finney 1998)				    data, processes output data
First Order Fire Effects Model 	 Stand-level first-order fire effects modeling	 Calls the program 
	 (FOFEM) (Reinhardt et al. 1997)		  system
Landscape Treatment Designer	 Landscape-level fuel treatment planning	 Calls the program 
	 (LTD) (Ager et al. 2012)		  system
Fire Family Plus (Main et al. 1990)	 Analysis of fire danger indices and weather	 Calls the program
1 Adapted from table 1 in Ager et al. 2011. 
2 FVS, FFE-FVS, SVS and FlamMap are the programs most frequently used with ArcFuels10.

ArcFuels10 Application
ArcFuels10 can be used for both project planning and fuel management research. It 
has three major applications, listed in order of increasing complexity: (1) modeling 
fuel treatments with FVS\FFE-FVS, (2) simulating landscape-level fire behavior 
and fuel treatments, and (3) using burn probability modeling and risk analysis to 
measure the performance of fuel treatments.

Modeling fuel treatments with FVS/FFE-FVS— 
ArcFuels10 adds a spatial context to FVS and facilitates its application for both 
stand and landscape modeling of fuel treatments. All functionality and exten-
sions available for use within FVS are available in ArcFuels10. This includes the 
FFE-FVS, which also incorporates the carbon model and the climate extension 
(Climate-FVS) (Crookston et al. 2010). ArcFuels10 stand-level analysis with FFE-
FVS typically involves simulating activities like thinning as well as surface fuel 
treatments such as pile burning, mastication, or broadcast burns, and examining the 
changes to fire behavior and effects such as tree mortality. At the stand level, the 
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Figure 2—The ArcFuels10 toolbar has been set up to follow a typical fuel treatment planning workflow (gray boxes). Steps include 
obtaining data, critiquing and updating data, modeling existing conditions, creating treatment alternative(s), and assessing the 
effectiveness of the alternative(s). Different processes are possible at the stand and landscape levels and are shown accordingly. 
Black boxes are specific to ArcFuels10 functionality.
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intention is for users to have access to digital orthophotos to see the vegetation in 
stands (delineated by an ArcGIS stand shapefile layer) and be able to point and click 
on individual stands to run FFE-FVS and SVS. When this is completed, ArcFuels10 
generates an Excel workbook with FFE-FVS outputs and graphs generated in each 
worksheet. At the landscape scale, modeled outputs are written to an Access® 
database. The selection of which stands to run through FFE-FVS is user-defined 
and can range from a single stand to the entire landscape. Additionally, ArcFuels10 
makes it possible to build landscape files from the FFE-FVS outputs for fire behav-
ior modeling in FlamMap to test treatment alternatives with simulated wildfires.

Much of stand-level modeling involves validating data and iteratively examin-
ing different treatment combinations on a suite of stands that collectively comprise 
a coordinated landscape fuel treatment strategy. Direct links to the prescription 
files allows efficient editing of the keywords, making easy comparisons possible. 
The validation or assessment of fuel treatment prescription(s) at the stand level 
can also be applied to larger landscapes to developed landscape-level treatment 
alternatives. Posttreatment stand development and fuel dynamics can be used to 
determine retreatment frequency over time. In addition to running FVS/FFE-FVS 
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for a single prescription, ArcFuels10 has the ability to analyze treatment prescrip-
tions by altering a single keyword parameter over set step amounts. This provides a 
way to explore how different management prescriptions affect stand structure and 
fire behavior. 

Simulating landscape fire behavior and fuel treatments—
Landscape analysis of fuel treatment scenarios examines the aggregate effect of all 
treatments on potential wildfire behavior (Collins et al. 2010). The spatial arrange-
ment, unit size, and total area treated are of importance to fuel treatment effective-
ness (Finney 2001, 2007; Finney et al. 2007). Landscape fuel treatment plans can be 
derived from a number of methods, including the use of models such as the Treat-
ment Optimization Model (TOM) within FlamMap or the Landscape Treatment 
Designer (LTD), within or outside of ArcFuels10, based on specific needs (point 
protection of structures), wildfire hazard or risk, or expert opinion.

Regardless of the fuel treatment plan, fuel treatments can be “applied” at the 
landscape scale two ways in ArcFuels10. The first is by simulating all stands through 
FFE-FVS with treatment prescription(s). The second is by using appropriate stand-
level FFE-FVS runs, monitoring data, or expert opinion to determine treatment 
adjustment factors to alter raster data to represent posttreatment conditions. Within 
ArcFuels10, it is possible to store the treatment adjustment factors, then apply the 
changes to select locations in the landscape in a single step. Arc-Fuels10 streamlines 
the preparation of landscape files (LCPs), which characterize the fuel environment 
for use with spatial fire modeling programs such as FARSITE and FlamMap. With 
ArcFuels10 LCPs can be created from raster data (such as LANDFIRE) (Rollins 
2009), from FFE-FVS simulations, from attributed shapefiles, or from multiple 
sources. ArcFuels10 also provides tools for quick postprocessing of modeled fire 
behavior outputs to analyze treatment effects in ArcGIS. 

Burn probability modeling and risk analysis—
The incorporation of the minimum travel time (MTT) (Finney 2002) fire spread 
algorithm into FlamMap makes it feasible to rapidly simulate thousands of fires that 
can then be used to generate burn probability maps. With the release of FlamMap5, 
it is now possible to obtain two key files necessary for wildfire risk assessments. 
FlamMap5 creates a Fire Size List (FSL) file that contains the coordinates and 
the final fire size of each randomly ignited fire in a MTT burn probability run. In 
addition, the Flame Length Probability (FLP) file output contains data on the burn 
probability and intensity from the randomly ignited fires for every pixel within the 
landscape. The FLP file is used to calculate the conditional flame length. These  
files are described in more detail in the “Risk” subsection of the “ArcFuels10  
Functionality” section of this document.
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Burn probability maps coupled with conditional flame length maps can be 
used to complete wildfire risk assessments. The outputs can be used to create risk 
matrices to categorize the landscape based on likelihood of a fire occurring (burn 
probability) and potential intensity (conditional flame length). This categorization 
can highlight “hot spots” in the landscape for fuel treatment planning (fig. 3a). 
The outputs can also be used to create risk scatter plots to assess the relative risk 
between and among values (fig. 3b). Expected loss where there is a direct link-
age between fire behavior and fire effects can be calculated and graphed (fig. 3c). 
Expected loss is possible for factors such as threatened or endangered species 
habitat (Ager et al. 2007), carbon (Ager et al. 2010a), or trees (Ager et al. 2010b). 
Finally, for values for which there is no direct linkage between fire behavior and fire 
effects, such as in the wildland-urban interface, response functions can be applied 
to calculate expected losses and benefits (Calkin et al. 2010).
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Figure 3—Examples of wildfire risk assessments using FlamMap5. (A) Wildfire risk maps where burn probability (BP) and conditional 
flame length (CFL) are categorized based on a risk matrix to highlight “hot spots” for fuel treatment planning, (B) wildfire risk scatter 
plot showing the relative risk of individual structures; structures that have low BP and low CFL (circled in green) have a lower relative 
risk than those with higher BP and conditional flame length (circled in red), (C) calculated expected loss of individual tree species under 
varying treatment intensities. Graphs B and C are adapted from Ager et al. 2010b.

How Is ArcFuels10 Different From ArcFuels9?
One of the key concepts in developing ArcFuels is combining separate, special-
ized tools to accomplish analysis that draws on a variety of disciplines to answer a 
variety of questions about the consequences of management decisions. The ques-
tions may involve the projected impacts on vegetation, wildlife, and watersheds, 
as well as the risks of wildfire to both human and non-human values. To explore 

One of the key concepts 
in developing ArcFuels 
is combining separate, 
specialized tools to 
accomplish analysis 
that draws on a 
variety of disciplines 
to answer a variety 
of questions about 
the consequences of 
management decisions.
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the impacts of multiple management plans, a researcher or planner must be able to 
run simulations using a variety of state-of-the-art tools. ArcFuels has always had, 
at its core, the concept of bringing together tools to aid researchers and planners in 
exploring the consequences of decisions.

When ESRI released ArcGIS 10, it moved from Visual Basic for Applications 
(VBA) to the .NET framework as its core programming language. This change 
prompted a need to reprogram ArcFuels for continued use within ArcMap. We took 
the opportunity to streamline forms within ArcFuels and design it to better follow a 
logical workflow by moving menus to more appropriate locations. To the end user, 
ArcFuels10 is very similar to ArcFuels9, but to the programming community it is 
quite different.

The .NET framework provides more powerful tools for developing more robust 
applications and is specifically designed to make it easy for programmers to take 
advantage of each other's work without reinventing or rewriting the same code. By 
providing libraries of functions in the form of Dynamic Linked Libraries (DLLs), 
.NET enables one programmer to write a module that is then incorporated into 
another programmer's project. Whereas VBA provided a limited ability to use 
DLLs, support for using DLLs is much greater in .NET and is, in fact, one of its 
core features. ArcFuels10 is designed to encourage the developers of primary tools 
to provide those tools in modular form, so that other programmers can combine the 
core functionality of multiple tools in ways that support the needs of end users.

Using ArcFuels on Citrix
Thin-client or distributed computing is a system of multiple autonomous comput-
ers that communicate via a network. Thin-client computing removes software 
requirements; users do not need to have the necessary programs installed on their 
machines. This is very helpful in the case of programs such as ArcGIS, where the 
program is quite large and computing needs are high. People with less powerful 
computers can use a thin-client to access and run programs they would otherwise 
be unable to do. All the data applications and data are housed, supported, and 
deployed from the server (fig. 4).

ArcFuels10 has the same capability within the U.S. Forest Service's Enterprise 
Production Data Center at Kansas City (also known as “Citrix” or the T-drive). 
Citrix has ArcGIS and the Microsoft Office® programs required to run ArcFuels10®. 
The forest growth and fire behavior programs are supplied for the user, similar 
to running them on your own PC. Citrix is accessed via the Internet (http://apps.
fs.usda.gov/Citrix/auth/login.jsp), but you must be on the Forest Service network 
(in the office or via VPN). One main advantage to working in Citrix is that it is 
not necessary to have ArcGIS loaded on your computer. Other benefits of working 
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in Citrix are accessing its large data storage capacity and more robust computing 
speeds, having the ability to share data with other users, and not needing to back up 
data. Citrix houses all the programs necessary to run ArcFuels10 (\\ds.fs.fed.us\efs\
FS\Reference\GeoTool\agency\Application\ArcFuels\ArcFuels10).

Other systems, such as the Interagency Fuel Treatment Decision Support 
System (IFTDSS, http://iftdss.sonomatech.com) use the distributed computing 
concept via their online system. Data and programs are all stored in a single portal 
for managers to access and share data. However, at this time, IFTDSS is not fully 
functional.

Overview Assumptions
This overview introduces ArcFuels10 and the tools available within the system. The 
reader is assumed to have a working knowledge of ArcGIS/ArcMap10, FVS, and 
FlamMap. Specific details about these programs will not be covered. For a basic 
introduction to these programs, refer to the ArcFuels10 Tutorial and Supplemental 
Information (Vaillant and Ager [N.d.]) and for full details, please refer to the tutori-
als and training provided with the programs. 

Thin-client PCs

Citrix servers

Internet login

Figure 4—Schematic of thin-client/distributed computing for the USDA Forest Service.
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ArcFuels10 Functionality
As mentioned, ArcFuels10 is a library of ArcGIS macros developed to streamline 
fire behavior modeling and spatial analyses for fuel treatment planning. These 
macros are executed via a custom toolbar in ArcMap (fig. 5). 

The toolbar consists of a number of menus, many with multiple options found 
in drop-down lists and sometimes multiple tabs in the associated forms. The 
ArcFuels10 toolbar also has a “tool,” the forest stand icon that is used to select a 
polygon (stand) or a raster cell from data loaded into the ArcMap table of contents.

The layout of the toolbar is intended to follow the workflow of fuel treatment 
planning (table 2). The premise is that fuel treatment planning often starts at the 
stand level to assess fuel treatment impacts that can then be extrapolated to the 
landscape. Before landscape-level fire behavior simulations can be completed, 
landscape files need to be created. Finally, ArcFuels10 has a group of tools that are 
useful for pre- and postprocessing fire behavior outputs and completing wildfire 
risk assessments.

Figure 5—ArcFuels10 toolbar.

Table 2—Summary of ArcFuels10 toolbar functionality

Menu	 Description

Stand	 Set up options for FVS/FFE-FVS. Includes applying fuel treatment prescriptions, treatment analysis,   
		  and treatment comparison tools. External linkage to open SVS.

Stand Select Tool	 Toggle button to select individual stands within the landscape to run FVS/FFE-FVS.

Landscape	 Multiple functions: (1) apply prescriptions to the landscape, (2) set up and running of FVS/FFE-FVS,  
		  (3) complete a treatment analysis with FVS/FFE-FVS, (4) a tool to join FVS/FFE-FVS outputs to a  
		  stand shapefile, and (5) the inclusion of the LTD program.

Build LCP	 Used to build landscape files (LCP) for FlamMap/FARSITE from FVS/FFE-FVS databases, rasters   
		  (i.e., LANDFIRE), an attributed shapefile, or a combination of data sources.

Wildfire models	 External linkage to open select (NEXUS, FARSITE, FlamMap, BehavePlus, FOFEM, and Fire Family  
		  Plus) fire behavior models. Internally coded version of BehavePlus (“Behave Calculator”) for quick  
		  stand-level comparisons of fire behavior.

Risk	 Tools to streamline wildfire risk assessments coupled with FlamMap5 outputs.

Tools	 A mixture of tools to modify raster values, convert ASCII files to rasters, and export attributes to Excel.

Project	 Forms to import, update, and export project settings linking ArcFuels10 to the programs listed in table  
		  1 and linking spatial data to programs.
FVS/FFE-FVS = Forest Vegetation Simulator/Fire and Fuels Extension to FVS, SVS = Stand Visualization System, FARSITE = Fire Area Simulator, 
FOFEM = First Order Fire Effects Model, LTD = Landscape Treatment Designer.
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Figure 6—Spatial linkage between the stand shapefile and the FVS_StandInit (top right) and FVS_TreeInit (bottom right) data tables 
within the FVS-ready database for stand 566 in the supplied ArcFuels demonstration data set. Draping the stand shapefile over aerial 
imagery can help identify stand(s) of interest.

The functionality of each menu will be described in the following sections, 
moving from left to right across the toolbar.

Stand
ArcFuels10 can be used to interactively run FVS/FFE-FVS for individual stands 
assuming that the user has the proper data. ArcFuels10 links FVS data to a stand 
shapefile, making it spatially explicit by linking the unique stand identification 
number (also known as “STAND_ID”) from a FVS-ready database to the location 
on the ground via an attributed shapefile (fig. 6). Draping the stand shapefile over 
aerial imagery aids the user in identifying stands to run with the tool or in visual-
izing the outputs. If the aerial imagery is current, it can also be used in conjunction 
with the FVS outputs to validate or update data as needed. 

The stand functionality can be used to run FVS/FFE-FVS for one stand at 
a time using the FVS interface integrated within ArcFuels10. The user does not 
need to leave ArcFuels to run FVS. Many of the FFE-FVS functions have been 
“hardwired” in ArcFuels10 to streamline the fuel treatment planning process. Once 
the Select Stand Tool is activated, the user simply points and clicks on a stand in 
ArcMap to initiate FVS. If all the settings are correct for the intended purpose, the 
user can click from one stand to another without having to revisit the FVS settings.

The Stand menu has a drop-down list with five options, Select Stand: Run 
FVS, Select Stand: FVS Treatment Analysis, Select Stand: FVS Compare 

ArcFuels10 can be 
used to interactively 
run FVS/FFE-FVS for 
individual stands, 
by linking FVS data 
to a stand shapefile, 
making the data 
spatially explicit.
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Treatments, View FVS Files, and Select 
Stand: Display Details (fig. 7). The four 
options with the Select Stand Tool icon 
to the left are used in conjunction with the 
Select Stand Tool (forest stand icon to the 
right of the Stand menu). 

Select Stand: Run FVS—
The FVS Inputs tab of the Select Stand: 
Run FVS form (fig. 8) is where the link-
age between the stand shapefile and FVS 
database are set. Treatment prescriptions 
can also be selected by choosing keyword 
prescription (KCP) files, which outline fuel treatment prescriptions (such as 
thinning from below, pile burning, broadcast burning, etc.).

Figure 7—Stand menu with the associated 
drop-down list and Select Stand Tool (stand 
icon to the right of the Stand menu) on the 
ArcFuels10 toolbar. These are used together 
to do the stand-level forest growth, fuel treat-
ment prescription testing, and fire behavior 
modeling within ArcFuels10.

Figure 8—The FVS Inputs tab of the Select Stand: Run FVS form is where the linkage between 
the spatial data and FVS database are set, and where keyword component prescription files (KCPs) 
can be applied. The form is set to run the supplied ArcFuels10 demonstration data.
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The FVS Options tab of the Select Stand: Run FVS form (fig. 9) is where 
the number of cycles and time steps for FVS runs and the fuel model set(s) that 
FFE-FVS will use are specified. Other hardwired options include the generation of 
a tree list for a specified year, a cut list, the ability to pause the FVS run at the end 
for debugging, and the option to override the FFE-FVS fuel model selections with 
others in the input database. Output options are also selected using this tab. Options 
include creating and opening Excel workbooks with or without graphics, writing 
files for use with NEXUS, and viewing outputs in SVS.

Figure 9—The FVS Options tab of the Select Stand: Run FVS form is where the options for an  
FVS/FFE-FVS run are specified and the output types are selected. The form is set to run the Blue 
Mountain variant of FVS/FVS-FFE for 10 one-year cycles, allowing FVS/FFE-FVS to choose the 
fuel models from either the Scott and Burgan (2005) or Anderson (1982) sets and to display the 
outputs in SVS and create an Excel workbook.

Once an FVS run is completed, the user has the option to view the results in 
SVS (fig. 10) and/or generate an Excel workbook (fig. 11) with or without graphs. 
These options are in addition to outputting the standard FVS output files.



14

GENERAL TECHNICAL REPORT PNW-GTR-875

Select Stand: FVS Treatment Analysis—
The Treatment Analysis tab of the Select Stand: FVS Treatment Analysis form 
(fig. 12) allows a single parameter to be varied within a KCP to test the effects on 
modeled outputs such as stand structure or fire behavior. This is handy when trying 
to determine how intensely to thin a stand or to see the effects of varying wind-
speed or fine dead fuel moisture on projected fire behavior. When this is used,  
FVS/FFE-FVS is run in “batch mode” automatically, running the stand through for 

Figure 10—Aerial imagery of stand 566 from the supplied ArcFuels demonstration data and SVS visualization for the initial year 
(inventory conditions).

Figure 11—Excel workbook displaying the FFE-FVS Potential Fire report for a 10-year simulation run for stand 566 from the supplied 
ArcFuels demonstration data. Many reports are hardwired to be output for all runs in ArcFuels10; each report is represented in individual 
worksheets (tabs) in the workbook.
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Figure 12—The Treatment Analysis tab of the Select Stand: FVS Treatment Analysis form is 
used to compare the effect of varying a single parameter on modeled outputs. The form is showing an 
analysis in which thinning intensities are varied to maintain a target of 20 to 100 ft2/ac basal area in 
20 ft2/ac increments.

Figure 13—Sample of Excel workbook graph for stand 570 showing the effect on crowning index 
(the windspeed (mph) required to sustain active crown fire) when varying thinning intensity based 
on remaining basal area for 20, 40, 60, 80, and 100 ft2/ac.

each step amount specified in the form. This form contains the same FVS Inputs 
and FVS Options tabs (see figs. 8 and 9, respectively) as the Select Stand: Run 
FVS form. Outputs are saved to an Excel workbook and graphs are created if those 
options are selected in the FVS Options tab (fig. 13).
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Select Stand: FVS Compare Treatments—
The Compare tab of the Select Stand: FVS Compare Treatments form (fig. 14) 
allows for direct comparison of two treatment alternatives. When this form is used 
an Excel workbook with graphs is automatically created and opened (fig. 15). This 
allows for quick comparisons of treatment alternatives over the span of the simulated 
years. The information can also be used in fuel treatment prescription development 
when stand data are available for only a subset of a larger landscape. This form con-
tains the same FVS Inputs and FVS Options tabs (see figs. 8 and 9, respectively) as 
the Select Stand: Run FVS and Select Stand: FVS Treatment Analysis forms.

Figure 14—The Compare tab of the Select Stand: FVS Compare Treatments form is used 
to compare the modeled output of two different treatment prescriptions. In the form, the two 
treatment prescriptions being compared are one in which a fuel treatment (thin, fuel move-
ment, and prescribed burn) occurs before a wildfire is simulated in 2007 (Combo.kcp) and a 
no-treatment alternative with the same simulated wildfire in 2007 (Wildfire2007.kcp).

View FVS Files—
The View FVS Files (fig. 16) form is used to quickly view the FVS KEY (*.key) and 
OUT (*.out) files from past runs (using the drop-down list). The files can be viewed 
in the text box, or opened in Notepad (using the Open File in Notepad button) or 
Excel (using the Open Spreadsheet button). The KEY file is a keyword record file 
that FVS reads to complete a run and includes information on the location of the 
stand and tree data, specifics on run duration, and prescriptions applied. The OUT 
file is a text file containing all the outputs from an FVS run.



17

ArcFuels10 System Overview

Figure 15— Sample of Excel workbook chart for stand 570 created for various carbon stocks (ton/acre) when comparing the two 
treatment prescriptions in figure 14.
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Figure 16—The View FVS Files form quickly displays the KEY or OUT files from past FVS/FFE-
FVS runs with the additional options of opening the files using Notepad or Excel. The OUT file for 
stand 542 from the demonstration data is shown.
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Select Stand: Display Details—
The Select Stand: Display Details form displays information about the trees and 
fuel loads from the FVS input database for the point selected when the data are 
available and for the landscape rasters if they are loaded (fig. 17). This still works 
when only FVS data or raster data are available; both are not needed.

Figure 17—The 
Select Stand: 
Display Details 
form, which displays 
information about the 
stand and landscape 
data for a selected 
point. The Tree List 
and Fuels Data are 
from the FVS input 
database and the 
Landscape Data are 
from rasters loaded 
into ArcMap.

Landscape
The Landscape menu is used when one desires to run FVS/FFE-FVS for more than 
one stand at a time. Like the stand-level FVS/FFE-FVS functionality, ArcFuels10 
links a FVS-ready database to a stand shapefile, making it spatially explicit, and 
includes a graphical user interface (GUI) to run FVS without leaving the system. It 
is possible to use data that has a one-to-one linkage between stands represented in 
the FVS-ready database and the stand shapefile, or a one-to-many relationship in 
which there are fewer stands in the database than polygons in the shapefile. When a 
one-to-many relationship exists, the stands in the database are imputed to the vari-
ous stands in the shapefile, which is the case with Most Similar Neighbor (MSN) 
(Crookston et al. 2002) data, or to individual raster pixels for Gradient Nearest 
Neighbor (GNN) (Ohmann and Gregory 2002) data. For Forest Service employees, 

The Landscape menu 
is used when one 
desires to run FVS/
FFE-FVS for more than 
one stand at a time.
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Figure 18—Landscape menu with the asso-
ciated drop-down list from the ArcFuels10 
toolbar.

the FSVeg Spatial Data Analyzer (http://fsweb.nris.fs.fed.us/products/FSVeg_ 
Spatial_Data_Analyzer/documentation.shtml) can be used to obtain FVS data  
at the landscape level for use with ArcFuels10. 

In addition to FVS/FFE-FVS capabilities, the Landscape menu has a link to 
the LTD program (Ager et al. 2012), which is used to design fuel treatment plans 
using an attributed stand shapefile. Attributes from FVS/FFE-FVS are often used to 
populate the stand shapefile for LTD.

The Landscape menu has a drop-
down list with five options, Assign FVS 
Prescriptions, Run FVS, FVS Treatment 
Analysis, Join FVS Outputs, and Land-
scape Treatment Designer (fig. 18). The 
first four options are all associated with 
running FVS and the last opens the LTD 
program. 

Assign FVS Prescriptions—
The Assign FVS Prescriptions form allows the user to assign KCP prescriptions 
to stands and store them in the FVS database for use with the Run FVS and FVS 
Treatment Analysis forms. Records are populated with the KCP file name for each 
stand using the Assign FVS Prescriptions options (fig. 19). This allows the user to 
create and store unlimited treatment alternatives using multiple KCP files. Although 
different KCP files can be used in a single alternative, only one can be assigned per 
stand.

Figure 19—Linkage between individual stands and the FVS database and the KCP files assigned for one fuel treatment 
alternative, “Alt1_Combo.”
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Figure 20—Assign FVS Prescriptions form with the Selecting Individual Stands option 
selected. The form is set to assign the “Combo.kcp” to the “Alt1_Combo” field in the FVS 
database for each stand selected.

The form has three options (buttons) for assigning prescriptions. The first 
option, Selecting Individual Stands (fig. 20), is used in conjunction with the 
Select Stand Tool. Prescriptions are assigned to a user-defined field in the stand 
table of the FVS database. The user sets the options in the Assign FVS Prescrip-
tions form, pushes the Select Stand: Assign Rx button, then closes the form, 
turns on the Select Stand Tool, and points and clicks on individual stands to 
assign KCP files to each.

The second option, Using Arc Selected Stands (fig. 21), assigns prescriptions 
to stands selected in ArcMap. The selection options in ArcMap can be used to 
quickly select stands requiring treatment based on any number of attributes in the 
stand shapefile (e.g., distance to structures, stand slope, etc.).
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Figure 21—Assign FVS Prescriptions form with the Using Arc Selected Stands option 
selected. The form is set to assign the “pileburn.kcp” to the “Alt1_WUI” field in the FVS 
database for the Arc Selected stands. 

The third option, Using TOM (fig. 22), uses an integer raster consisting of 
only 0s and 1s, where a value of 1 indicates the need for a treatment and a value 
of 0 is no treatment needed. Treatment Optimization Model (TOM) is a tool in 
FlamMap that outputs a 0/1 treatment raster. The Using TOM option is not limited 
to treatment rasters output by TOM but can be used with any 0/1 raster created in 
ArcMap. This function pairs extremely well with the ArcMap Raster Calculator. 
For example, with the Raster Calculator, new 0/1 rasters based on specific criteria 
(e.g., all burnable fuels, slopes > 30 percent, south aspects, etc.) can be created, then 
ArcFuels10 can be used to apply prescriptions.

Because rasters and shapefiles rarely line up exactly or the 0/1 raster might be 
based on non-stand-specific criteria (such as fire hazard from FlamMap runs), a 
user-defined treatment threshold is used. The user decides what percentage of the 
stand must be represented by a value of 1 to have the KCP applied. In addition to 
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assigning the KCP files, a text summary file of how many stands were selected  
for treatment and a new 0/1 ASCII text file for the prescription assignment can  
be created.

Run FVS—
The Run FVS form has two tabs related to running FVS. The landscape Run 
FVS form is similar to that under the Stand menu and offers a compact FVS 
interface with many options. A single stand, a set number of stands, ArcMap-
selected stands, only stands with prescriptions, or all the stands in the landscape 
can be run. Prescriptions can be applied to all stands or to selected stands by link-
ing to the prescription field in the input database (see Assign FVS Prescriptions 
above). The number of FVS cycles and years is set with this form. In addition to 

Figure 22—Assign FVS Prescriptions form with the Using TOM option selected. The form is set  
to apply the “Underburn2003.kcp” to the “Alt1_TOM” field based on the 0/1 raster “trt_location.” 
The program knows to which stands in the FVS database to assign the prescriptions because of the 
use of a Stand ID Raster.
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the ability to write and use KCPs, some helpful FVS/FFE-FVS functions are hard-
wired in ArcFuels10 as options: fuel model selection, carbon reports, turning off the 
FFE-FVS reports, creating a tree list for a given year, and generating a cut list. Inputs 
are set using the FVS Inputs (fig. 23) and FVS Options (fig. 24) tabs. A few differ-
ences between the Stand and Landscape Run FVS forms exist. With the Landscape 
form, SVS outputs are not created, nor can NEXUS inputs be created, the output file 
is an Access database rather than an Excel Workbook so no graphs are created, and 
the Parallel Processing Extension (Crookston and Stage 1991) can be run through the 
Landscape form but not the Stand form.

FVS Treatment Analysis—
The FVS Treatment Analysis tab has three options (buttons) for analyzing treat-
ment effects on stand characteristics and modeled fire behavior and effects. The FVS 
Treatment Analysis form also has the FVS Inputs (fig. 23) and FVS Options (fig. 
24) tabs. Within the Treatment Analysis tab the first option, Vary Parameter (fig. 
25), is similar to the FVS Treatment Analysis function in the Stand menu, where a 
single parameter within the prescription file is varied in a stepwise fashion.

Figure 23—The FVS Inputs tab of the Run FVS form. The form is set to run all the stands in 
the supplied ArcFuels demonstration landscape using the Blue Mountain variant of FVS and will 
apply prescriptions to those stands with them assigned using the “Alt1_Combo” field in the FVS 
stand data table.
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The second option, Substitute Value (fig. 26), substitutes a single value based 
prescription with “<_>” inside a command indicating the value to be altered. The 
minimum and maximum values and the step amount are specified by the user.

The third option, FLP Specific (fig. 27), is used to create loss function data-
bases for use with FlamMap5 or FSim (Finney et al. 2011) specific FLP files. FSim 
is the large fire simulator used by the Fire Program Analysis (FPA) System (http://
www.fpa.nifc.gov) to do wildfire risk assessments for the United States (wildfire 
risk will be described in detail in the “Risk” section later). An FLP file is a gridded-
point shapefile that contains information about burn probability and fire intensity 
for each point. The spacing of the points is user defined within FlamMap5 and 
FSim. The FLP files generated in FlamMap5 either contain 6 or 20 fire intensity 

Figure 24—The FVS Options tab of the Run FVS form. The form is set to run 10 one-year 
simulations in which FVS/FFE-FVS selects fuel models from both the Scott and Burgan (2005) 
and Anderson (1982) sets and will write the outputs to the “Alt1_Combo.mdb” database file.
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Figure 25—Treatment Analysis tab with the Vary Parameter option selected. The form is set to 
vary the thin from below part of the “Combo.kcp” file to a target basal area of 60, 70, 80, and  
90 ft2/ac.

levels (FILs); those from FSim only contain 6 FILs. An FIL is a measure of fire 
behavior and is based on flame length. This FVS Treatment Analysis option is 
used in conjunction with a KCP that uses the FLAMEADJ keyword to control the 
flame length within each FFE-FVS simulation to be coupled with the FLP outputs 
for further analysis with the Risk menu options within ArcFuels10. The FLP 
Specific option not only runs simulations to match the FIL categories for the FLP 
files, but also runs a no-fire simulation. For more information about FlamMap5 and 
FSim, please refer to each program’s Web site at http://www.firemodels.org/index.
php/national-systems/flammap and http://www.fpa.nifc.gov, respectively.
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Figure 26—Treatment Analysis 
tab with the Substitute Value 
option selected. Within the 
“WildfireVariableWind.kcp,” 
windspeed will be varied from  
5 to 50 mph by 5 mph steps. 

Figure 27—Treatment Analysis tab 
with the FLP Specific option selected 
set up to run FFE-FVS simulations 
to build a loss function database for 
use with an FLP with 20 fire intensity 
levels (FILs). 
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Figure 28—The Join FVS 
Outputs form is used to join 
FVS/FFE-FVS outputs to the 
stand shapefile layer. The form 
is set to join the FVS_Compute 
table for 2005. The FVS_Com-
pute table is specific to 
ArcFuels10 and includes data 
pertinent to canopy character-
istics relevant for landscape 
fire behavior modeling and 
modeled fire behavior from 
FFE-FVS. See figure 29 for a 
sample map.

Figure 29—A sample map created 
after joining the FVS_Compute 
table with severe flame length (ft) 
outputs for 2005 from a landscape 
FFE-FVS run to the stand shapefile 
for the supplied ArcFuels demon-
stration area.
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Join FVS Outputs—
The Join FVS Outputs form (fig. 28) joins FVS/FFE-FVS outputs from any table 
in the output database for a given year to the stand shapefile layer. This is a very 
useful tool for visualizing various FVS output metrics across a landscape (fig. 29).
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Landscape Treatment Designer—
The Landscape Treatment Designer form (fig. 30) is available when the LTD 
program is downloaded and linked via the Edit Project Setting form, which is 
described in the “Project” section of this document. The LTD program is a multicri-
teria spatial prioritization and optimization system to help design and explore land-
scape fuel treatment scenarios (fig. 31). The program fills a gap in the fuel treatment 
planning process between fire model programs such as FlamMap and planning 
systems such as ArcFuels10 by providing a systematic way of planning spatially 
explicit fuel treatments. The LTD uses inputs on spatial treatment objectives, 
activity constraints, and treatment thresholds, then identifies optimal fuel treatment 
locations with respect to the input parameters. The input data represent polygons 

Figure 30—The Landscape Treatment Designer (LTD) form, which can be used for fuel treatment planning. LTD is set 
to create a fuel treatment alternative with aggregated treatment blocks to protect large trees until all stands are included. 
Stands are considered for treatment only when fire type is passive or active crown fire (FireType>=2.00) and slope is less 
than or equal to 50 degrees (Slope_deg<=50.00). Each treatment block can treat between 500 and 850 ha but will ultimately 
be larger with the inclusion of stands not requiring treatment.

ArcFuels10 streamlines 
the process of building 
landscape files (LCPs) 
from FVS/FFE-FVS 
output databases, an 
attributed shapefile, or 
raster data for use in 
fire behavior modeling 
programs such as 
FARSITE and FlamMap.
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that are attributed with information about expected fire behavior 
and the polygon’s overall contribution to one or more landscape 
management objectives. Four types of output files are generated 
with each run: (1) a text file with all the input data with treatment 
locations indicated, (2) a summary text file of input parameters 
and output results, (3) a results comma separated file with the input 
parameters and output results, and (4) a shapefile with an attribute 
table that identifies patch locations and stands selected for treat-
ments. For more detailed information about the LTD, refer to Ager 
et al. 2012.

Build Landscape File (LCP) 
Running FlamMap or FARSITE, two commonly used fire behavior 
modeling programs, requires a landscape file (LCP). LCPs are 
binary files containing a compilation or “sandwich” of ASCII data, 
including elevation, slope, aspect, fuel model, canopy cover, canopy 
height, canopy base height, and canopy bulk density (fig. 32). In 
addition to the eight layers listed above, a FlamMap or FARSITE 
LCP can include duff loading and course woody fuels layer, but 
these are not easily obtained or often used. The new Wildland Fire 
Assessment Tool (WFAT) (http://www.frames.gov/partner-sites/
niftt/tools/niftt-current-resources/) also uses an LCP file with 
additional data requirements (fuel loading model 
and tree list data) for the fire-effects functional-
ity. For more information about these programs, 
please visit their Web sites. 

ArcFuels10 streamlines the process of 
building LCPs from FVS/FFE-FVS output 
database(s), an attributed shapefile, or raster 
data. ArcFuels10 has the ability to reduce the 
analysis area based on another raster’s extent 
or coordinates, quickly apply treatments, and 
export ASCIIs and rasters created along with  
the LCP.

Figure 31—The Landscape Treatment Designer 
treatment solution from figure 30, in which the 
lighter shade within each treatment block (1–4) 
is marked as needing treatment.
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Figure 32—Landscape file (LCP) schematic, adapted from Finney 
(2006).
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The Build LCP menu has a 
drop-down list with four options, 
Build LCP using FVS or GNN 
Data, Build LCP using Raster 
Data, Build LCP using Shapefile 
Data, and Build LCP by Merging 
Data (fig. 33).

Figure 33—Build LCP menu with the 
associated drop-down list from the  
ArcFuels10 toolbar.

Build LCP Using FVS or GNN Data—
The Build LCP Using FVS or GNN Data form builds LCPs and/or rasters from 
FVS or GNN (Ohmann and Gregory 2002) output database(s) that are spatially 
linked via a raster that ties the FVS stand-identification numbers to their spatial 
location on the landscape. This is a raster version of the stand shapefile. 

To use this function, FVS/FFE-FVS must be run first for all unique stands 
within the landscape. It is possible to have FVS data from one stand be applied to 
multiple stands in the landscape, as is common with GNN and MSN data. Because 
FVS/FFE-FVS reports only the fuel model and canopy characteristic layers (canopy 
cover, canopy height, canopy base height (CBH), and canopy bulk density (CBD), 
topographic rasters (elevation, slope, aspect) must be obtained and loaded into the 
ArcMap table of contents to use this tool. 

If the FFE-FVS-derived fuel model assignments are not desired, it is possible 
to override these with another fuel model raster (such as one downloaded from 
LANDFIRE) by using the Use ArcGIS Raster Layer option.

When the Apply Treatments option is selected, two FVS/FFE-FVS databases 
can be combined to build the LCP and rasters. This is often used when running 
FVS for selected stands with prescriptions, rather than running the entire landscape 
as a time-saving step. ArcFuels10 replaces data from the FVS Output Database 
(typically a no-treatment run with all stands represented) with that from the Treated 
Stands Database for all stands present.

The Build LCP Using FVS or GNN Data form consists of two tabs, FVS 
Data (fig. 34) and Output (fig. 35). The FVS Data tab is where the data sources are 
specified (topographic rasters, FFE-FVS output database(s), and related data table 
and data fields). The Output tab is where the desired extent of the output LCP and/
or rasters is specified. There are three options: Default extent: Intersection of the 
selected data layers, which is the typically rectangular extent of the topographic 
and Stand ID Raster, Use another layer to limit the extent, which uses another 
raster to build the LCP and/or rasters for a smaller analysis area (this is often used 
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Figure 34—Build LCP Using FVS or 
GNN Data form FVS Data tab. The 
form is set to combine a no-treatment 
database (notreat.mdb) in which all 
stands were run through FVS without 
applying a treatment KCP and a treated 
database (Atl1_Combo.mdb) where only 
stands receiving treatment were run 
through FVS for the year 2005.

Figure 35—Build LCP Using FVS 
or GNN Data form Output tab set to 
create rasters and a LCP limited by the 
extent of a smaller area defined by the 
“subarea” raster.

when the topographic rasters are much larger in extent than the Stand ID Raster), 
and Manually limit the extent of the output, where the user types in the bounding 
coordinates desired.
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Build LCP Using Raster Data—
The Build LCP Using Raster Data form builds LCPs and/or rasters from ArcGIS 
rasters. This eliminates the need to export the rasters as ASCII files, which is 
required for creating LCPs in FlamMap and FARSITE. A common source of raster 
data for landscape-level fire modeling is LANDFIRE (http://www.landfire.gov); 
however, it is also possible to use other sources such as locally derived data. 

The Build LCP Using Raster Data form consists of two tabs, Raster Data 
(fig. 36) and Output (fig. 35). The Raster Data tab is where the raster sources are 
specified. When the Apply Treatment Adjustment option is selected, treatments can 
be rapidly applied using a treatment adjustments database or an attributed shapefile. 
The treatment database is coupled with rasters location and type of treatment (fig. 
37). Multiple treatment alternatives can be maintained in a single treatment adjust-
ments database where the Treatment Type ID Field is linked to multiple Treatment 
Type Raster(s) created for each alternative. Similarly, the attributed shapefile 
includes the treatment adjustments and a 0/1 field indicating if the adjustments 

Figure 36—Build LCP Using Raster Data form Data Sources tab. The tab is set to create a 
treated LCP file using a treatment adjustment database to replace the fuel model and canopy base 
height and multiply the remaining canopy characteristics by the adjustment factors. The location 
and type of treatments are specified by the “trt_location” and “trt_type” rasters, respectively.
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should be applied to a specific polygon. Treatment adjustments can multiplication 
factors (e.g., 0.2 would reduce input data by 80 percent), replacement factors (e.g., 
2 m for CBH), or no change. These options are both convenient ways to build and 
archive different treatment alternatives. The Output tab is identical to Build LCP 
Using FVS or GNN Data (fig. 35).

Build LCP Using Shapefile Data—
The Build LCP Using Shapefile Data form builds LCPs and/or rasters from 
attributes within a shapefile. As with the Build LCP Using FVS Data form, 
topographic rasters (elevation, slope, aspect) must be obtained and loaded into  
the ArcMap table of contents to use this form.

The Build LCP Using Shapefile Data form consists of two tabs, Shapefile 
Data (fig. 38) and Output (fig. 35). Raster data are needed to define the stand 
locations and the topography. The fuel layers (surface fuel model and canopy 
characteristic) are selected from attributes within the specified stand shapefile.  
The Output tab is identical to Build LCP Using FVS or GNN Data (fig. 35).

Figure 37—Treatment adjustment factors can be used in conjunction with untreated fuel 
rasters and a treatment type raster to rapidly apply treatments, build an LCP, and output 
the treated rasters.

Treatment adjustments table within the treatment 
adjustments database

Raster of treatment type pixels.
1 in yellow = heavy thin & underburn
2 in green = underburn only
3 in blue = light thin & underburn
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Untreated fuel rasters

Treated LCP and fuel rasters
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Build LCP by Merging Data—
The Build LCP by Merging Data form allows the user to mix and match rasters 
from varying data sources (e.g., LANDFIRE, FFE-FVS, GNN, local, or LiDAR) or 
mosaic together multiple rasters of different spatial extents into one seamless layer 
for any given data set needed to create an LCP and/or rasters. It is even possible for 
the rasters to have different units, but they must be the same resolution and projec-
tion, and be snapped. 

The Build LCP by Merging Data form consists of two tabs, Merge Data (fig. 
39) and Output (fig. 35). The navigation button to the right of each data required 
opens a new form where the rasters can be selected and the units defined (fig. 40). 
The Output tab is identical to Build LCP Using FVS or GNN Data (fig. 35).

Figure 38—Build LCP 
Using Shapefile Data form 
Shapefile Data tab. The tab 
is set to create an LCP file 
using fuel model and canopy 
characteristics specific to 
each stand derived with FVS/
FFE-FVS. 
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Figure 39—Build LCP by Merging Data form Data Sources tab set to mosaic together LANDFIRE rasters with 
FVS/FFE-FVS-derived rasters.

Figure 40—Select Data 
Sources form shown for 
combining FVS/FFE-FVS-
derived canopy height with 
LANDFIRE data. The order 
in which data are selected 
specifies how they will be 
used; those listed above 
replace those below.
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Wildfire Models
As mentioned, ArcFuels10 leverages existing pro-
grams. The Wildfire Models menu offers “shortcuts” 
to open selected fire behavior models (NEXUS, 
FARSITE, FlamMap, BehavePlus, FOFEM, and Fire 
Family Plus) for external use (fig. 41). The paths to the 
programs executable (*.exe) files must be set using the 
Edit Paths form, which is described in the “Project” 
section. For information about each of the programs, 
refer to their documentation.

In addition to opening the mentioned programs, 
ArcFuels10 also has the Behave Calculator, which is 
run through an integrated GUI. 

Behave Calculator—
The Behave Calculator (fig. 42) is hardwired into ArcFuels10 and uses the same 
equations as the SURFACE module in Behave Plus. The Behave Calculator can 
be used to quickly assess changes to modeled surface fire rate of spread and flame 
length for changes to fuel model, slope, fuel moisture, and/or windspeed inputs. 

Figure 42—Behave Calculator form with calculated rate of spread and flame length for fuel 
model GR7 (also known as 107) with a 25 percent slope under the specified fuel moisture and 
windspeed conditions.

Figure 41—Wildfire Models 
menu with the associated 
drop-down list from the 
ArcFuels10 toolbar.

ArcFuels10 leverages 
existing programs and 
the Wildfire Models 
menu offers shortcuts 
to open NEXUS, 
FARSITE, FlamMap, 
Behave Plus, FOFEM, 
and Fire Family Plus.
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Risk 
Wildfire risk is the product of the likelihood of a fire occurring, the associated fire 
behavior when a fire occurs, and the effects of the fire (Calkin et al. 2010, Finney 
2005, Scott 2006). Although fire effects can be both positive and negative, in the 
field of wildfire risk the benefits are most often not considered. Wildfire risk miti-
gation is achieved when any of the three aspects (likelihood, behavior, or effects) 
are reduced. 

Wildfire likelihood is often quantified with burn probability (BP), which is 
an estimate of the possibility of a specific location burning given a single random 
ignition under the burn conditions specified in the simulation. Burn probability 
modeling represents a major advance in wildfire behavior modeling compared to 
previous methods, such as those in which fire likelihood was quantified with rela-
tively few (<10) predetermined ignition locations. This advance resulted from the 
development of an MTT fire spread algorithm (Finney 2002) that makes it com-
putationally feasible to simulate thousands of fires and generate burn probability 
and intensity maps over large areas (10 000 to 2 000 000 ha). High-performance 
computers are typically used for MTT simulations within FSim (Finney et al. 
2011). The algorithm as implemented in FlamMap (version 3 and version 5, Finney 
2006) is adequate for project scale (e.g., <25 000 ha) evaluations. Extensive testing 
has shown that this algorithm can replicate large fire boundaries in the heteroge-
neous landscapes that typify much of the wildlands in the western United States. 
FSim is based on the same platform as FlamMap, in which MTT calculations are 
used to model fire behavior and is the program used by FPA to do fire risk assess-
ments for the United States. 

FSim and FlamMap5 each output an FSL text file for each fire along with a 
final perimeter shapefile and FLP text file in addition to a BP ASCII raster file. An 
FSL file contains the location, a unique identification number, and the final fire 
size in acres for all randomly ignited fires. An FLP file is a gridded point shapefile 
that lists the location, overall burn probability, and the conditional probability 
by FIL categories. The FLP files generated in FlamMap5 contain either 6 or 20 
FILs; those from FSim contain only 6 FILs. The six FIL categories are expressed 
as flame lengths in 2-ft (0.61-m) categories (FIL1 – FIL5; FIL6 > 12 ft). The 20 
FIL categories are expressed as flame lengths in 0.5-m categories (FIL1 – FIL19; 
FIL20 > 9.5 m).

A quantitative definition of fire risk includes fire behavior probabilities and 
fire effects for highly valued resources (HVRs). Finney (2005) calls this quantita-
tive definition expected net value change (NVC). The expected NVC can include 
financial, ecological or other values at present day, or future discounted values, 

Wildfire risk is 
the product of 
the likelihood of 
a fire occurring, 
the associated fire 
behavior when a  
fire occurs, and the 
effects of the fire
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and can include both positive and negative impacts of fire (Finney 2005). When 
wildfire benefits are not considered, expected NVC can be simplified to expected 
loss (EL). The calculation of EL is the sum of the product burn probability and 
loss for different fire intensity levels summed across the area in question (Ager et 
al. 2007, 2010b):

EL = ∑ (BPi ) (Li)

where BPi is the probability of a fire at the ith flame length category (conditional 
probability) and Li is the loss (e.g., northern spotted owl habitat, large trees, or 
carbon) at the ith FIL. Expected loss is then summed by FIL for each scenario. 
The FLP contains information for BPi and Li is within the loss function database 
created in FVS/FFE-FVS with the FVS Treatment Analysis form FLP Specific 
option. In addition to the EL, conditional expected loss (CEL) can be calculated. 
The CEL is the observed loss given a fire occurs and is calculated as:

CEL = ∑ (BPi /BP) (Li)

where BPi is the probability of a fire at the ith flame length category, BP is the burn 
probability, and Li is the loss at the ith flame length category. 

When it is not possible to directly link loss to flame lengths as is possible 
for trees or carbon, response functions can be used instead (Calkin et al. 2010). 
Response functions translate fire effects into NVC for any given HVR. In each 
response function, NVC is based on the flame length of the fire and represents 
both beneficial and adverse effects to the resource. Response functions are devel-
oped by considering the different ways in which various HVRs might respond 
to fire of different intensities (fig. 43; table 3). For computational ease response 
variables use the midpoint NVC value (table 3).

Conditional flame length (CFL) is the probability-weighted flame length given 
a fire occurs and is a measure of wildfire hazard. The conditional flame length is 
calculated using FLP files with the following equation:

CFL = ∑ (BPi /BP) (Fi)

where BPi is the probability of a fire at the ith flame length category, BP is the burn 
probability, and Fi is the flame length midpoint of the ith FIL category. 
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Figure 43 —Sample graphs of response functions of net value change by flame length categories for four different highly  
valued resources. Adapted from Calkin et al. 2010.
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Table 3—Response function examples with percent net value change (±20 percent) for 
four flame length categories (low, moderate, high, and very high)1

Response function description	 Low	 Moderate	 High	 Very high

All fire is beneficial; moderate benefit at low fire	 +50	 +20	 +20	 +20 
	 intensity and mild benefit at higher intensity.

Moderate benefit at low fire intensity decreasing	 +30	 +10	 -10	 -30 
	 to a moderate loss at very high fire intensity.

Moderate increasing loss from mild loss at low	 -20	 -30	 -40	 -50 
	 intensity to a moderate loss at very high intensity.

Losses greatly increasing from low to very high	 -10	 -40	 -70	 -80 
	 over all fire intensities.
1 Adapted from Calkin et al. 2010.
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Convert FLPs—
The Convert FLPs form (fig. 45) converts FLP files from FlamMap5 and FSim into 
a shapefile (fig. 46). This combines two ArcGIS processing steps into one; it con-
verts an XY text file into an events file, then exports it as a shapefile with defined 
spatial reference.

Figure 44—Risk menu with the associated 
drop-down list from the ArcFuels10 toolbar.

Figure 45—Convert FLPs form setup to convert an FLP output from FlamMap5.

ArcFuels10 streamlines the 
calculation and processing of risk 
metrics such as NVC, EL, CEL, and 
CFL within the Risk menu. The Risk 
menu has a drop-down menu with nine 
options, Convert FLPs, Batch Con-
vert FLPs, Convert Fire Size List, 
Batch Convert Fire Size Lists, Net 
Value Change, Expected Impacts, 
Conditional Flame Lengths, Aver-
ages, and Display Results (fig. 44).

ArcFuels10 streamlines 
the calculation and 
processing of risk 
metrics such as net 
value change, expected 
loss, and conditional 
flamelength.



41

ArcFuels10 System Overview

Figure 46—Example of converted FLP shapefile attributes table (A) and shapefile (B) for an FLP with six FILs.

Figure 47—Batch Convert FLPs form set to convert four FLP files and define their 
spatial reference all at once.

Batch Convert FLPs—
The Batch Convert FLPs form (fig. 47) has the same functionality as the Convert 
FLPs form with the added benefit of converting multiple files at once. 
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Figure 48—Convert Fire Size List form set to convert an FSim file.

Figure 49— Example of converted Fire Size List shapefile attributes table (A) and shapefile (B) showing three ignitions over aerial 
imagery.

Convert Fire Size List—
The Convert Fire Size List form (fig. 48) converts FSL files from FlamMap5 and 
FSim into a shapefile (fig. 49). An FSL file is a text file with information about 
the location of each ignition and the final fire size for all randomly ignited fires in 
FlamMap5 or FSim. As in the Convert FLPs form, this combines two ArcGIS 
processing steps into one; it converts an XY text file into an events file, then exports 
it as a shapefile with defined spatial reference. Because the FSL files have unique 
attribute names specific to FlamMap5 and FSim for the X and Y coordinates, there 
are program-specific input options. In addition, an Other option has been added 
and can be used to convert non-FSL information such as plot locations; the X and Y 
coordinate labels are specified by the user for this function to work.
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Batch Convert Fire Size List—
The Batch Convert Fire Size List form (fig. 50) has the same functionality as 
the Convert Fire Size List form with the added benefit of converting multiple 
files at once. 

Figure 50—Batch Convert Fire Size Lists form set to convert three Fire Size List 
(FSL) files and define their spatial reference all at once. With this form, the FSLs must 
all be from the same program, FlamMap5, FSim, or have the same X and Y coordinate 
headers specified with the Other option.
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Figure 51—Net Value Change form set to calculate the expected and conditional NVC for a FlamMap5 20-bin metric FLP 
within hypothetical lynx habitat using the stylized Response function 7. The calculated values will automatically be added to the 
new “ENVC_lynx” and “CNVC_lynx” fields specified in the form.

Net Value Change—
Response functions translate positive and negative fire effects into net value change 
(NVC) to of highly valued resources (HVRs) based on the flame length categories. 
The Net Value Change form (fig. 51) is used to calculate the NVC for any HVR 
using an FLP, 0/1 HVR raster, and appropriate response function values (see table 
3 for examples). The form calculates both the expected and conditional NVC and 
appends the values to the input FLP file.
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Figure 52—Expected Impacts form set calculate the expected loss of live and dead large 
ponderosa pine trees and to calculate conditional flame lengths.

Expected Impacts—
The Expected Impacts form (fig. 52) provides an interface to combine loss 
function databases created in FVS/FFE-FVS with FLP files to calculate expected 
and conditional expected loss as well as conditional flame length. The outputs are 
appended to the FLP shapefile.

To use this form, the “Stand_ID” must be attributed in the FLP file for each 
point. Also, a loss function database must exist where flame length was varied 
according to the FLPs FILs. The FLP Specific option on the Treatment Analysis 
form (fig. 25) is designed specifically for this function.
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Figure 53— Conditional Flame Lengths form set to calculate 
the conditional flame lengths in a new attribute field named 
“CFL_ft” within a FlamMap5-derived FLP with six FILs.

Conditional Flame Lengths—
The Conditional Flame Lengths form (fig. 53) is used to calculate CFLs. The 
CFLs can be appended to a preexisting field in the FLP or a new field can be cre-
ated. There are two options for calculating CFL; one for FLPs with 20 FILs and one 
for FLPs with 6 FILs. The output units are the same as the input units for the type 
of FLP; 20 category FLPs are in meters and 6 category FLPs are in feet.

Averages—
The Averages form (fig. 54) is used to average or summarize FLP or FSL point 
data by a shapefile. The shapefile can represent anything of interest, such as forest 
stands, threatened or endangered species habitat, wildland-urban interfaces (WUIs), 
or a combination of factors. The Averages form has the ability to intersect the FLP 
or FSL point data or use data that have already been intersected. The output is an 
Excel workbook summarizing the expected burn probability, and conditional burn 
probability or average fire size depending on the input, for each polygon within the 
shapefile (fig. 55).
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Figure 54—Averages form set to summarize fire size by forest type in the supplied ArcFuels 
demonstration data.

Figure 55—Example of Fire Size 
List averages output, in which fire 
size is averaged by forest type, as 
well as the entire landscape.
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Figure 56—Example of wildfire risk scatter plots (A) and curves (B) from a 20-category FLP averaged by forest type.

Figure 57—Display Results form set to create a raster of burn 
probability from a FlamMap5 FLP file.
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These data can be used to create scatter plots and curves to represent risk (fig. 
56). Scatter plots and risk curves can be used to show the relative risk of different 
subunits (polygons) within a landscape (Ager et al. 2010b). 

Display Results—
The Display Results form (fig. 57) has 
two functions: (1) conversion of a field in 
an FLP shapefile to a raster with defined 
spatial reference; and (2) customized 
display of existing raster layers, to either 
show values in a ramp from low to high, 
or show values that exceed a user-defined 
threshold.

Tools
The Tools menu is where other functions 
are housed that are not specific to the 
other menus in the ArcFuels10 toolbar. 
This houses a form to update raster 
values, forms to convert ASCII files to 
rasters (postprocessing for FlamMap and 
FSim), and a form to export the attributes 
of a shapefile to a spreadsheet.
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Figure 58—Tools menu with the associated 
drop-down list from the ArcFuels10 toolbar.

The Tools menu has a drop-down list 
with four options, Modify Raster Values, 
Convert ASCII to Raster, Batch Convert 
ASCII to Raster, and Export Shapefile 
Attributes (fig. 58). 

Modify Raster Values—
After critiquing data for accuracy (informally, on the ground, using the Stratton 
(2009) methodology, or otherwise), it is most likely that modifications will be 
required to reflect local knowledge of fuel models and fire behavior, recent man-
agement activities, recent wildfires, etc. Realize, however, that when modeling 
landscape-level fire behavior, one must accept that there will be some error in the 
data, but one should always strive to minimize this. It is important to document 
changes as well as make them incrementally, making it easier to see the effect of 
the changes and backtrack, if necessary. With ArcFuels10, complex raster value 
replacements are easily made on the individual raster data components, rather than 
on the landscape file. Tools such as the FARSITE landscape calculator and the 
LANDFIRE Total Fuel Change Tool (LFTFC) (http://www.frames.gov/partner-
sites/niftt/tools/niftt-current-resources/) are available to make changes on the 
landscape file, but are generally limited to simple changes (Stratton 2009). 

Within ArcFuels10, the Modify Raster Values form (fig. 59) is available to 
update or correct raster data. When the form is used, a projected raster file is 
created and added to ArcMap. The changes can be made to either floating point or 
integer data. Either discrete values or ranges of values can be replaced, multiplied 
by, or added to. Options include making changes to the entire landscape or to 
selected areas using another raster or shapefile to define the location. The output 
raster extent also need not be identical to the input data.

Within ArcFuels10, 
the Modify Raster 
Values form is 
available to update 
or correct raster 
data. Either discrete 
values or ranges 
of values can be 
replaced, multiplied 
by, or added to. 
Options include 
making changes to 
the entire landscape 
or to selected areas 
using another raster 
or shapefile to define 
the location.
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Figure 59—Modify Raster Values form set to update canopy cover within a recent fire. When canopy cover is between 
75 and 100 percent the value is multiplied by 0.5; when canopy cover is between 50 and 75 percent the value is multiplied 
by 0.25; and when canopy cover is between 10 and 50 percent, the value is multiplied by 0.1 (to maintain 90 percent of the 
original cover).

Convert ASCII to Raster—
The Convert ASCII to Raster form (fig. 60) combines two ArcGIS processing 
steps into one. It converts an integer or floating point ASCII file into a raster and 
defines the spatial reference at the same time. This form is most commonly used to 
postprocess data created in FlamMap for further analysis and mapping in ArcMap.
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Figure 60—Convert ASCII to Raster form set to convert a flame length ASCII file 
output from FlamMap to a floating point raster file named “nt_fl.”

Figure 61—Batch 
Convert ASCII to 
Raster form set to 
convert two crown fire 
activity files created 
in FlamMap to integer 
rasters. Not all ASCII 
files in this folder 
are being converted 
together because the 
remainder should be 
converted as float-
ing point rather than 
integer rasters.

Batch Convert ASCII to Raster—
The Batch Convert ASCII to Raster form (fig. 61) has the same functionality as 
the Convert ASCII to Raster form, with the added benefit of converting multiple 
files at once. 
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Export Shapefile Attributes—
The Export Attributes to Spreadsheet form (fig. 62) exports the attributes table 
from a shapefile into Excel and opens the workbook. This is useful for further 
analysis outside of ArcMap. The form eliminates the need to export the attributes as 
another file type, then import the data into Excel.

Figure 62—Export Attributes to Spreadsheet form set to export the attributes from the 
“mt_emily_stands” shapefile.

Figure 63—Project menu from the 
ArcFuels10 toolbar.

Project
ArcFuels10 saves the settings for the most recent project when the ArcMap session 
is saved. But people often work on multiple projects at once, alternating between 
them. The Project menu has options for export-
ing and importing settings, so that once a project 
is set up and the linkages are defined, the user 
can quickly move from one project to another.

The Project menu has a drop-down list with 
four options, Project Settings, Import Settings, 
Export Settings, and Import Project Settings 
(fig. 63). 

Project Settings— 
The Projects Settings form is used to set the linkages to programs ArcFuels10 
uses with the Programs tab (fig. 64) and the folders necessary to run ArcFuels10 
with the Folders tab (fig. 65). If programs such as FlamMap or FVS are already 
installed, the location of the *.exe can be set from the program installation folder 
rather than by using the supplied files.
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Figure 64—Programs tab of the Project Settings form with all supplied programs loaded.

Figure 65—Folders tab of the Project Settings form.

Not all programs need to be linked in the Programs tab, only those planned on 
being used. FVS, SVS, and FlamMap are the programs most commonly used with 
ArcFuels10. All the programs listed are available within the programs and extra 
program folders at the ArcFuels Web page. It is recommended that you visit the 
program Web pages for the most up-to-date programs before starting new projects.
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Import Settings—
The Import Settings option loads a preexisting text file with the information for  
a project. The text file contains information about the data loaded and program 
locations for an existing project (fig. 66).

Export Settings—
The Export Settings form exports the settings for a current project into a text file 
(see fig. 66 for an example). It is highly recommended that the project settings be 
exported for each project after setting up the project. 

Import Project Settings—
The Import Project Settings form (fig. 67) allows settings from a preexisting 
ArcFuels9 project database to be imported into ArcFuels10. Once it is imported, 
use the Export Settings form to save a new text file for use with future ArcFuels10 
sessions. 

Figure 66—Example of project settings text file created for the supplied ArcFuels10 
demonstration data.

Figure 67—Import Project Settings form set to import project settings from ArcFuels9.
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ArcFuels10 Download and Installation Instructions
System Requirements
To run ArcFuels10, the following programs are required:
•	 ArcMap version 10.0 with the Spatial Analyst Extension
•	 ArcCatalog
•	 Microsoft Office Excel
•	 Microsoft Office Access
•	 Notepad, WordPad, or another text editing program.

Obtaining ArcFuels10
ArcFuels10 is contained in an ESRI ArcGIS Add-In file (*.AddIn). There is no 
installation program for ArcFuels10 (administrative privileges are not required). 
The download sites contain a complete set of demonstration data, programs needed 
for demonstration purposes, supporting documentation for the programs, and a 
tutorial (Vaillant and Ager [N.d.]).
1. 	 Create an ArcFuels directory (i.e., C:\arcfuels on your computer or T:\...\

arcfuels, where ... is your workspace on the T-drive for use with Citrix) 
and obtain the following files from the ArcFuels10 Web site (http://www.
fs.fed.us/wwetac/arcfuels/downloads.html) or the T-drive (T:\FS\Reference\
GeoTool\agency\Application\ArcFuels\ArcFuels10):
a. 	 ArcFuels10—ESRI ArcGIS Add-In file for ArcFuels10 (i.e., toolbar 

buttons) and the project settings text file for the demonstration data. 
b. 	 Data—The folder includes demonstration data for the Mt. Emily project 

area and will be used throughout the available tutorial.
c. 	 Programs—The folder contains FVS/FFE-FVS, SVS, FlamMap5, 

NEXUS, Fire Family Plus, and LTD. 
d. 	 Docs —The folder is an optional download. It contains supporting lit-

erature about the programs and relevant scientific publications.
e. 	 Extra_programs—The folder is an optional download. It contains addi-

tional fire behavior models: FARSITE, FOFEM, and Behave Plus.
f. 	 Exercise_outputs—The folder is an optional download. It contains the 

outputs for all exercises in the available tutorial.

2. 	 Unzip (to unzip to C:\arcfuels, right-click on each zip folder → WinZip 
→ Extract to here) or transfer the unzipped folders from the T:\ to your 
ArcFuels directory. Verify that they are not further nested (i.e., C:\arcfuels\
data\data, fig. 68). 
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Installing the ArcFuels10 Add-In
This section will explain how to install the ArcFuels10.esri Add-In file for ArcMap. 
Two sets of instructions are included for use with ArcMap on your computer and 
for ArcMap on Citrix. Once the Add-In is installed, it will be available for all future 
ArcMap sessions. You can turn on and off the ArcFuels10 toolbar the same as all 
other toolbars in ArcMap.

For ArcMap installed on your computer—
1. 	 Open ArcMap (Start → All Programs → ArcGIS → ArcMap 10) from  

your computer.
2. 	 From the main ArcMap toolbar open the Add-In Manager window  

(ArcMap toolbar → Customize → Add-In Manager…, fig. 69).
a. 	 Click the Customize… button to open the Customize window (fig. 70).
b. 	 Click the Add from file… button and navigate to and select the 

ArcFuels10.esriAddIn file from the C:\arcfuels folder.
c. 	 When the Esri ArcGIS Add-In Installation Utility window (fig. 71) 

opens, click the Install Add-In button to complete the installation.
d. 	 When the Added Objects… window (fig. 72) opens, click OK to close 

the window and proceed.
e. 	 Verify that the ArcFuels Toolbar was added and is checked (see fig. 70), 

then click Close to close the Customize window.

Figure 68—Data structure for ArcFuels10. Be sure the “data,” “outputs,” and “programs” folders are not further nested in other folders.
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* Additional directories can be added under C:|\arcfuels for your own
  data and and can be defaults are set in the Project Settings form
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Figure 69—The Add-In Manager window is used to add and remove Add-In files in ArcMap.

Figure 70—The Customize window.
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Figure 71—The ESRI ArcGIS Add-In Installation Utility window contains 
information about the version of ArcFuels10 being installed (the version for this 
figure is 1.0.0). ArcFuels10 is updated periodically as bugs are found and fixed 
and enhancements are made; check the ArcFuels Web page for updates.

Figure 72—The Added Objects… window, show-
ing the ArcFuels forms within the ArcFuels toolbar.
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For ArcMap installed on Citrix—
1. 	 From Internet Explorer, open the Citrix Web page: http://apps.fs.fed.us/

Citrix/auth/login.aspx.
2. 	 Log into Citrix using your username and password (these are the same as 

your computer login information, fig. 73).

Figure 73—Citrix login screen.

Figure 74—The Main folder within Citrix.

3. 	 From the Main (fig. 74) Citrix folder open the GIS folder.
a. 	 Within the GIS folder, open the ArcGIS 10 folder and open ArcMap.

4. 	 Follow step 2 from the For ArcMap installed on your computer directions above.
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Setting Up the Demonstration Data
This section will explain how to add the demonstration data and load the project 
setting with ArcMap open and the ArcFuels10.esriAddIn file loaded. Two sets of 
instructions are included for use with ArcMap on your computer and for ArcMap 
on Citrix.

For ArcMap installed on your computer—
1. 	 Add the demonstration data layer, Demo_data.lyr, located in the  

C:\arcfuels\data folder (ArcMap toolbar → File → Add Data →  
Add Data).

2. 	 Load the project settings using the Import Settings form (ArcFuels 
toolbar → Project → Import Settings). Once the form is open,  
navigate to and select the project setting file, arcfuels10_mtemily.txt, 
located in C:\arcfuels.

For ArcMap installed on Citrix—
1. 	 Add the demonstration data layer, Demo_data.lyr, located in the  

T:\…\arcfuels\data folder, where the … is your workspace (ArcMap  
toolbar → File → Add Data → Add Data).

2. 	 Because your workspace is a different path than where the data layer was 
created, the data sources needs to be set for all layers (fig. 75).

Figure 75—The 
exclamation points 
to the left of the file 
names indicate that 
they need their data 
sources defined.

a. 	 To set the data source, right-click on one of the layers Data → Repair 
Data Source, then navigate to the layer in your workspace ArcFuels 
data folder. This should repair all the data sources for all the layers. If it 
does not, repeat the process for the remaining layers with the exclama-
tion points to the left.

3. 	 Next, the location of the folders and programs need to be updated for your 
workspace.
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Figure 77—Project Settings form Folders tab set for use in Citrix where the ... 
indicates the path to your workspace.

Figure 76—Project Settings form Programs tab set for use in Citrix where the ... 
indicates the path to your workspace.

a. 	 Open the Project Settings form (ArcFuels toolbar → Projects →  
Project Settings) and select the Programs tab. Navigate to and update 
the program locations according to figure 76 where the … indicates the 
path to your workspace.

b. 	 Select the Folders tab and update the folder locations according to  
figure 77 where the … indicates the path to your workspace.

c. 	 Close the Project Settings form by clicking the Close button.

4.	 Export and save the new project setting in your workspace for future 
use (ArcFuels toolbar → Projects → Export Settings).
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English Equivalents
When you know:	 Multiply by:	 To find:

Meters (m)	 3.28	 Feet
Hectares (ha) 	 2.47 	 Acres
Square meters per hectare (m2/ha)	 4.37	 Square feet per acre
Tonnes per hectare (t/ha)	 0.446	 Tons per acre
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